4.1
4.2
43
44
4.5
4.6
4.7
| 48

49

Relative referencing, absolute referening and mixed referencing
4.10 Using Statistical functions;
411 SUMY(), AVG(), MAX(), MIN(), IF() with compound statements,

412 Inserting tables in worksheet, embedding charts of various types (Lines,
pie, bar, column, area) in worksheet

] 413 Using macros in worksheet

lr Objective of Learning |

MS Excel : Introduction and Concepts of Spread Sheet and Wori ]
Creating, Saving, Opening and Print & Print Preview

Closing of Spreadsheet

Entering Numbers, Text, Date and Time

Series using Auto Fill

Editing and formatting of Worksheet including changing color
Size, Font, Alignment of Text, Inserting and deleting cells

Row and Columns, Entering formula in call using Operator (+, -, x, /)
elc.

(10th)




}4.1 INTRODUCTION

MS Excel is one of the components of Microsoft office. It is also known as
Excel. MS Excel is a spreadsheet program. It is used to do calculations on your
data. In Excel you can create electronic spreadsheets.

Definition : Spreadsheet appears on screen as a matrix of rows and
columns, the intersections of which are identified as cells. With the use of
electronic sheet there is no need of paper, pencil or pen, eraser, calculator etc
and you need not to do calculation manually.

MS Excel is mainly used to do calculations. You can do any type of
mathematical, statistical, trigonometric and financial calculations very easily
in Excel. The results computed by excel are reliable and accurate. You can also
make charts and graphs using Excel to present data in graphical form. Some
commonly used spreadsheets program are: Lotus123, Tally and MS-Excel.

OPENING THE MS EXCEL

To work with Excel first of all you have to open it. The steps to start Ms-
Excel are given below:

Click on Start — All Programs — Microsoft Office - Miscrosoft Office Excel

2010. e o i TR
OO - o s
@ Eite Lnzp » £ Microsoft Office Access 2007
@ Mozila Firefox 5 Mirosoft Office Excel 2007
& Microsoft Office InfoPath 2007
t- Microsoft Office Outiook 2007
& Microsoft Office PowerPoint 2007
(o ® Windows Movie Maker & Murosoft Office Publisher 2007
'glxggoh word s 4alika » . Microsoft Office Word 2007
@ Adube ’ @ Maosoft Office Groove 2007
‘Goq*(h‘(ﬂ! © Adobe Acobat » 2 Marosoft Office Onetiote 2007
@ Quick Time for Windows ’ @ Microsoft Office 2010 Tools ’
@ Adcbe Photoshcp 7.0 P Mircsoft PowerPoint 2010
B Adcbe ImageReady 7.0
ST ILI B Adcbe Reader XI 8 Macrosoft word 2010
aH 4
£ [R.1S. OCR Registration
@ Dictiorary :

Fig. Opening Microsoft Excel 2010

110
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Or
To open MS- Excel using search box do the following :
1. Click on Start button to open Search box
2. Type Excel in the search box

3. Press enter key from keyboard

§ Search Results
File Edt View Fawrites Tooks Help
Q F Psexch | rows [+

® Neme In Folder
To start your search, lollow e insinctions ) Be left pare

® Search Results
File Edt View Fovorites Tools Heip
) Q¥ Psexch |y Foldes [@e

Nome In Foidr

MENCEL EXE-34CBE5. . C \WINDOWS Prefetch

= S EXCEL C:\Program Files\Mioosoft Office\Office1 2

1 Sewel w west  C\Program Files\Miorosolt Office\Office1 2

i KExcE C \Progrom Files\Microsoft Office\Office 14

T Sexcel eon mandfest € \Program Fikes\Microsoft Office\Office 14
| Cexca CAWINDOWS \Jrataller\$P st Cache \Maraged\0004

e Mironol Ofice Bece Compary | Misosof Corper sten F e v H

Fig. Search dialogue box
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4.1.1 CONCEPTS OF SPREAD SHEET AND WORKBOOQK

M.S. Excel is used for creating worksheets, tables and charts. In exce],
Wwe can do calculations in the easiest way. It helps us in analyzing data and
making it more formative for business purpose. In excel we can work with
worksheet and workbook. Worksheet is made of rows and columns, Exce
allows us to create workbook in different methods. We can create workbook
using two methods:

(?) Blank Worksheet
(#) Using Templates

T e—,

T e g e

Excel is mainly used for following purposes:

(1) Managing the Data bases.

(1) For processing Electronic Worksheet.

(iii) Manipulation of String Data.

(iv) For calculations and manipulation of Numbers.
(v) To prepare Bugdets.

(vi) Graphical representation of Data.

(vii) Prepare time table and chart.

(viii) Prepare various reports.

|
!
Workbook : A worksheet or sheet is a single page in a file created with |
an electronic spreadsheet program such as Microsoft Excel or Google Sheets.
A workbook is the name given to an Excel file and contains one or more
worksheets.

Spreadsheet : A spreadsheet is a sheet of paper that shows accounting
or other data in rows and columns; a spreadsheet is also a computer application
program that simulates a physical spreadsheet by capturing, displaying, and
manipulating data arranged in rows and columns.

Worksheet : A Worksheet is a collection of cells organized in rows and
columns. Each worksheet contains 1048576 rows and 16384 columns and serves
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as a giant table that allows you to organize information. Typically, a workbook
contains several worksheets with related content and only one of the
worksheets is active at a time

Parts of MS-Excel Windows

When you start Excel, its windows will be displayed on the screen. The
following figure shows the various parts of MS-Excel Window :

Maximize

T'"‘ ber Column

e Toolbar Formula Bar Miniesize j o
'—g.;‘ﬂ‘ J gy mmm / IR

«whwwuﬂmm\&- 2@ecdl

Ribbon ¢ Yo
r Deete * i ’
Group (Font) . [ﬂ omats Q@ [0,
(el 104

a3 .4
PG D V—— b L0

Fig. MS-Excel Window

'Qluck Access Toolbar : Above File menu there is Quick Access toolbar.
access to commands frequently. It has three buttons: Save as, Undo,



—

File Menu : The File menu is located on the upper-left corner of the Exce]
window.

Save Redo
-— Yneo l Quick Access Toolbar
o

e ] x Ld
B save as - Cuntomize Quick Access Toolbar
&5 Open -
Open
Close
= | Seve
ERax >
Recent frpe
Print Prevvew ac Print
New Speiling
I[ Undo
Print . .
Save & Send 5o Ascenaing
Sort Descencing
Help Ogen Recent +ie
1] Options More (ommanac
B Ewt Son Below e Auoon
Fig. File Menu Fig. Quick Access Toolbar

Title Bar : Excel displays the name of the workbook you are currently using

title bar. At the top of the Excel window, you can see Book1-Microsoft Excel
or a name.

Title bar
B e 'Bookl - Microsoft Excel =B 3}
Fig. Title Bar

Ribbon : In Excel, the ribbon is located below the Quick Access Toolbar.
On the ribbon, there are many tabs. Each tab displays several related command

groups. The contents of each tab can be displayed by clicking on the tab name
with the left mouse button. There is a dialog box launch

er in the bottom-right
corner of every group. 4

ada e T e
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Formula Bar : In this bar the cell address of the active cell is displayed
in the Name box which is located on the left side of the Formula bar. Cell
entries are displayed on the right side of the Formula bar. In the other words
Formula bar displays information entered in the current or active cell. The
contents of a cell can also be edited in the Formula bar.

If formula bar is not displayed in the window then perform the following
steps to display the Formula bar in window :

1. Click on View tab.

2. Click on Formula Bar under Show/Hide Group.

BEa & Bookl - Microsoft Excel

--. et Pgrlmme fomam Oe feses  vew

Wy~ g Q W S0 2 B, F W
- it n—~ R W -t = -—

Zowr o oo™ w =
avons [l 7 Scowen soncton [ eums fov - £33 B wetopecy Winsons -

P LT

c@ecd

7 oo [7 vamtngs

[

Formula Bar

Fig. Displaying Formula Bar

Status Bar : This bar is located at the bottom of the Excel window and
provides information such as the sum, average, minimum and maximum value
of selected numbers. By right-clcking on the Status bar, you can change what
displays on the Status bar.

R N A . ‘—?- ..N..’.m“;(:r.‘ 2 it ».G_-.---._-. :::-’;..5
Fig. Displaying Status Bar

Name Box : Name box shows the address of the current selection or active
cell. It is also used to go to a specific cell. In the Name box, type the cell name
and then press Enter key. Perform the following steps to go to cell number A5
by using Name Box :

L. Type A5 in the Name box.
2. Press Enter. - .

Moved to ‘;i

AS cell
Fig. Display Name Box




Working in Worksheet Of MS-Excel

(i) Using the Arrow keys : You can use Arrow keys to move around yoy,
worksheet. You can use Down arrow key to move document one cell at a time
and Up arrow key to move upward one cell at a time. Use the right and left

arrow keys to move right or left one cell at a time.

Navigation Keys : The Page Up and Page Down keys move up and down
respectively one page at a time. Press Ctrl key + Home key together, to move

to the beginning of the worksheet e.g. Cell Al.

Following table describes the function of Navigation keys :

S.No.| Keys Function
;o Up Arrow key To shift one cell up
2. Down Arrow key or To shift one cell down
Enter key
3. Left Arrow key To shift one cell left
4. Right arrow key or Tab| To shift one cell right
5. Home To go to the first column of the selected row
6. Ctrl + Home To go to the top left corner of ti1e spreadsheet
or cell A1l
Ctrl + End To go to the bottom of the worksheet
Ctrl + Right Arrow key | To go to the end of row
Ctrl + Down Arrow key| To go to the end of the column
10. Page UP To move the cursor up one screen at a time
11. Page Down To move the cursor down one screen at a time
12. Ctrl + G To go to a particular cell in the worksheet

(ii) Selecting Cells : To perform a function on a group of cells, you must

el

first select those cells by highlighting them. To select an area hold down the
left mouse button and drag the mouse over that area as shown in following

figure :
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Fig. Selecting Cells
(iii) Entering Data :

L. Click on the cell where you want to enter the data.

Sue 454 Street
TEI | 55 Street

— Insertion point
| |
Fig. Entering Data

2. Type the data. An insertion point appears in the cell as the data is typed.
3. After typing data, press Tab key to go to next cell. The data can be typed

in either the cell or the Formula bar.

(iv) Deleting Data : Use Backspace key to erases one character at a time

in the active cell.

(v) Editing a Cell Data : You can also edit the entered data. Click on the

cell whose data you want to edit and then press F2 key. You can also edit the

cell by using the Formula bar or can also edit the data by double clicking the
cell you want to edit.

- (vi) Wrap Text : When the typed text is too long to fit in the cell, then
the text overlaps the next cell. To avoid this you can wrap the text, perform
the following steps to wrap text :

1. Move to cell A2.
2. Type "Sunil Chowdhary".

(th) 17
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e~ CEES
MBS SRR TGS
1 Monitor
2 Sunil Chowdhary
3
_4____

Fig. Entering Data
3. Press Enter.
4. Return to cell A2.
5. Select the Home tab.

6. Click on the Wrap Text button

Wrap Text Option

EEda-0-- Bookl - Microsoft Excel
- Home  Insert  Pagelayout Formulas Data  Review\ View

lﬁ & caioi -1l A A = I[J ¥ ¢ Geneal

¢yo! ‘3 BIU- -3 A - EEREXE $-% > &3 °
Clipboard "« Font K Ahgr\rﬂgﬂl 3 5 _V_ngpgr* e 3

Fig. Wrap Text
Your text will be wrapped.

(vii) Delete a Cell Entry : To delete an entry in a cell or a group of cells,
place the cursor in the cell or select the group of cells and press Delete key.

(viii) Filling a range of cells :
The steps to fill the range of cells are :
1. Select the cell, type the data in the cell.

9. Position the mouse pointer over the fill handle.

o
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3. Press fill handle with left mouse button and drag the mouse to select
the range of cell. And release the mouse button.

Or

From keyboard press Shift key and Down key and select the cells or range
of cells. Press Ctrl + D keys to fill the data.

[ Al v (=
s Q____
L A A - &)
data

=

]

@ IN e W N e

Fig. Creating a Series
The contents of the first cell will be copied to all the cells of the selected

range.
Creating a Data Series : Data series is a series of numbers. Excel can
enter numbers automatically in a form of series. The steps to generate data

series are :
1. Type 100 in cell A1

bl A LLibad 8|
1 1
2
3
a
5
6
7 |
8 1
9 =

Fig. Creating a Data Series
2. Type 101 in cell A2
(mth) 119 J




3. Select both the cells

4. Position the mouse pointer over the fill handle.

5. Click and hold the left mouse button, and then drag it down.

Perform the following steps to create a Series of Months of Year :
1. Enter the value January in cell Al.

2. Enter the value February in cell A2.

Enﬁsw-h‘uacﬂ&ugu‘|

Fig. Creating a Series of months

3. Select both of the cells and press fill handle with left mouse button and |
drag the mouse. ‘

4. Tt will create the series of months automatically.

} 4.2 CREATING, SAVING, OPENING AND PRINT & PRINT i
PREVIEW ~ ”

4.2.1 Creating

To create a spreadsheet, you must either have a MS Excel or a computer
capable of creating a document on an online service.
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Perform the following steps to Create a file :
1. Click the File tab.
2. Click New.

i e
Lo

3. Under Available Templates, double-click Blank Workbook. Keyboard
shortcut To quickly create a new, blank workbook, you can also press CTRL+N.

4.2.2 Saving A File

Perform the following steps to Save the file :

1. Click on File menu.
Eed - o-]s

BN
bl save k,

SaveAs

(&7 Open

dOose

Recent

Fig. Displaying Save option in File menuv
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9. Click on Save button. The Save As dialog box will appear.

Folder Name

en 0w Ho-arrum
F
B
|9
@«
File Name

|

P pone ‘u.—{ -
B o T “
— G =)

Fig. Displaying Save As dialogue box
3. Go to the Folder in which you want to Save the file.

4, Type the name that you want to give to your file, in the File Name box.
5. Click on Save button.

Your file will be saved with the name given by you in the folder you specify.

4.2.3 Print & Print Preview

1. Click on File — Print option or Click to Ctrl + P.

Send the document Girectly 10 the default
panter without making change:

Punt Pregew
Preview and make changes 10 pages before
printing.

122 (10th)
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2. Then the below dialogue box will appear on the screen :

secton. For example, type 1, 3, 5~12
or plsl, pis2, pls3-pasl
Print what:  Document [¢] oom
Prnt: | All pages in range E Pagesper sheet: | 1page

Scale 1o paper sge: 1o Scaing

]
5]

=) [ o ]

3. Enter the page no. on Page Range blank box.

4. Then check the Print Preview of mentioned page.

D.l—hﬂml"t..
Recert -
New Bintr Papates
Sestngs 4"
| Pret Active Sheets. «
Sove & Sond : Cody priet the acto sheeny
Pages - =
Excel Tad nm . =
123 W25
Help ;
,__Ju-o—- -
] Ostiame
-~
nu NDeomad?om
J--u-— -
25 e LWon WBge 17
.4 . > - ‘ ‘m -
g - Pret Mewt: @ Mew sctiat
B Pepsmg v 431 dQ»

)
«
=



} 4.3 CLOSING OF SPREADSHEET

Perform the following steps to close MS-Excel :

1. Click on File menu.

2. Click on Exit. MS-Excel will close. Or

|-
[~ B

[ " R

3 e

[ Oow

Recent

Nea

Dot
Save & Send

e
1} Oocan
o K
Fig. In File menu displaying Exit option
Click on Close button on the right hand side of title bar.

Maximize

Minimiil CLOSE
BRe-ts . o  Bookl - Microsoh Excel LF“‘
--m. et Togtlacd  Tormem  Osa  Reves  Vew c@eedn}

Or
Press Alt + F4 key combination from keyboard.

It is a good practice to save your workbook before exiting Excel. Excel always
ask you to save the changes you made before exiting.

ﬁ Do you want 1o save e hanges you made o Book1?

1f you chk Dan't Save”, 8 recent capy of this Sie vl be temporardy avatabie.
\cmmaare }

=) (oorsowe | [Ccow | |

Fig. Confirm Save dialogue box
o




’ 4.4 ENTERING NUMBERS, TEXT, DATE AND TIME

1. Insert the current date into your text. This command inserts a content

control into your document — text that can be updated.
Click on Alt + Shift + D

2. Click on right button of mouse, then the below dialogue box will appear.

B
!
g

Please choose a field Freld propertes Freid aptons

e ) s
7] Use the Seka Era calender

: - |
M_'} e Bl died
o ~| 14 May 2019 '
{ . |uos-|9
|EdtTime 2019-05-14 |
b e |
| Time |14 May. 19
J 14May 2019 |
May 19
’Nav-w ‘
14-05-2019 06:51
[ 14052019 06:53:31
|6:51 AM
|6:51:31 aM ‘
| || os:st
| [ |os:s13 :
Bt} « Dl | |
= -1l — —h_ M = = Preserye formatting durng updates
Descpton:
The date the document was created
o ] [cmn ]

3. Then Click on Edit Field... option.
[CalibriBoc~ 11 =1 A" 4" A~ 7
BIEY-A-FEFE=-

& Cut

42 Copy

@ Paste

2! Update Field

Edit Field...

Toggle Field Codes

Font...

Paragraph...

2 Bullets 4
_[1,2 = Numbering »

il =h »

* tow)
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; 3. Now the Field dialogue will appear. Choose the Date.and Time optiop
| from drop down option. Now we can change required date, time and text.

|

Sy
! | Please choose a field Field propertes Field options
| | Sategories: Date formats: [ Use the Hiyidunar calendar
' | — ) T || | e s o L
ET— [ e
S 14 May 2019 |
) 140519
PrintDate 201905-14
SaveDate e 0
- 14May. 19 1
14 May 2019 !
May 19 |
May-19
14-05-2019 07:08
{ 14-05-2019 07:08:41
| 7:08 AM
‘ 7:08:41 AM
07:08
07:08:41
A |
> 1 (V] Preserye formatting during updates
Description:
The date the document was ceated
=) e )
Function Use
DATE() This Function is used to return a date, from a user-supplied
year, month and day.
TIME() This Function is used to return a time, from a user-supplied
hour, minute and second
NOW() This Function is used to return the current date & time
TODAY() This Function is used to return today’s date.

The Function Library

There are hundreds of functions available in Excel. Only some of these
function will be useful for the type of data to work with. There is no need to
learn every single function, but we may want to explore some of these.
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These functions can be accessed in the Function Library on the Formulas
tab. Here, we can search and select Excel functions based on categories such
as Fincancial, Logical, Text, and Date & Time. Now we will learn about

there function :
s R

-“merwmmm

. -
&
TN NN
f I PBME
Insert  AutoSum Recently Financial logicl Tet Dated loctup& Math  More
Function * Used . v *  Time* Reference * & Trig * Funcions *
Funchon Libeary

Inserting a function from the Function Library :
(i) Type your data in our worksheet take the following steps :

(¢7) Select the cell where the answer will appear (F3, for example).

4 A 8 G ) E
1 | Sr.No Particulars OrderQty Dateof Order Date of Delivery
2 1 Tea S 16-Oct-15 20-Oct-15
i3y 2 Soap 6 12-Sep-15 14-Sep-15
4 | 3 Wax 2 1C-Jun-15 15-Jun-15
S| 4 Ghee 8 10-Jun-15 12-Jun-15
6|l s il 20-Feb-15 22-Feb-15

(zi7) Click the Formulas tab.

(iv) From the Function Library group, select the function category
which is required. Here we select Date & Time.

i
| (v) Select the desired Function from the Date & Time drop-down menu.
! We'll choose the NETWORKDAYS function to count the days between the

order date and receive date.
- Home neent Page Lyous Fovmnsa: Dats Revew Vew Oecesone
A I pB0BaeE 5o
et AutoSum Recenty Foanciel Logical  Test Dsed icohupd M oee Name
Fundon . Uted + . . . Reterence * & Trg * Puncioms - [ L
p—— pe— L L e — Nemes
Q s | Datbraie
L—T——; —s——c—T_D_ Dar e s
A SN Partculas e | . :
& 1 Tea b
M 2 Soan 6 toss0mH
4 3 Wax 2 nOuR
N 4 Ghee ] e
: 5 on 2 P a
. MTWORKDary
. -nmmn—-\
0 nOw | Witart date eng
| u R
.% " ey [>T T er—
oty
i




() The Function Arguments dialog boX

will appear. Insert the cursoy

I T ¢ WL DR

3)
. ou want (E s
in the start_date then enter or select the cell(s) ¥
. ’ £ L
A 8 c o $ P o "
SrNO  Parvculars jor Qty re 0f re very _Noof Days
2 1 Tea 5 5 3 uxloao'x:« % ;::l’ls @
e Soap 6 12-Se0-13 1850015
3 wa 2 10-un-1% 15413
3 $ Ghee L] 10-Jun-13 12un-35 | neTwoRsDAYS ) - o
N 3 o 20-5e0-13 2-7e0-15 Start_date € &) - -
2 End_dote
: ol :
s -
10
:: ---.-.dd&”-‘-“"':'::m“._.nwu
1
Py
ii e =]
v

("Uii) Insert the cursor in the End_date then enter or select the cell(s) we
want (F3).

T _Pendtor Lbsan Detred Hamey NETWORIDAYS
NETWORKDAYS X h NETWORKDAYS(ELFS) St _date © o'
i nd_date +3 -9
A T T T R S B e A e - -
A StNo Pamculary OrderQty Dateof Order Dateof Debwery Noof Days - 0
B 1 Tea s 1800135 20015 O e
3 2 Soan 6 12 Sep-25 16-Sep- 18 tad_dute = b that wdde
- 3 Wax 2 10-sun13 15 Jun-15
5 - Gree 1 W-ion-18 2.0
; 5 o 20-Feb-1 nFeo1s A e
. PRpPye— =) (e ]
A w» . .
Funehor Lideasy Oefined Manes NETWOSIDAYS
’ — —
NETWORKDAYS  ~ K o & =NETWORKDAYS(E3F3) ot date © -
L__ _____ & AL tnd date 1) @
! - L] c 0 : E 1 F rscers %l -
1 SrNo Pamiulars OrcerQty DateofOrder  Dateof Deivery _Noot .
a1 Tea 5 16-0ct-15 20015 [YS(ELFS) | | natums the rumber of wihcle work e -
i 2 Soan . 12-5e0-18 14-5ep-15
~, Wax 2 10-3un-15 15-Jun-15 Skt & b e,
Bl Gree 2 10-3un-15 124un-15 View formula
S o 20-Fe-18 2Fed 15 Result
= Fomisread = 20186 =
L) b on e Functien
: ] Comer )

(viii) Click on OK, and the result will appear. Our results show that it took
10 day to deliver the order.

docs 16 SR IS e e -
1 Sr.No Particulars OrderQty Date of Order D“e;fhberl‘l;_éfy 5 o
B = e [
i 2 Soap 6 12-Sep-15 ,

14-Sep-15
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} 4.5 SERIES USING AUTO FILL

If the step value is a simple number, the fastest way to specify a growth
series is to enter the first two numbers and use the RIGHT-click menu of the
Fill Handle. Follow the steps below :

Lia | Copy Cells A

Fill Series
Fill Eormatting Only

flg ure 1 Fill Withgut Formatting

1
32
64
Linear Trend
Growth Trend 5

Series... k figure 3
figure 2

1. Type the first two numbers in the first two worksheet cells (figure 1).

2. Select these two cells, and hover the cursor over the lower right corner
to display the Fill Handle (+).

3. With the RIGHT mouse button pressed, drag the Fill Handle up, down,
or across to select the cells to be filled. Release the mouse.

4. From the menu that now displays, select Growth Trend (figure 2).

The autofill results are shown in figure 3. Because two numbers were
entered, Excel could determine the step value.

If you want a step value of 3, enter 1 and 3 into the first two cells (1x3=3).
What if you want a step value of 2, but you want the series to begin with the
lumber 5? You would enter 5 and 10 (5x2=10) in the first two cells.

(10th)
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} 4.6 EDITING AND FORMATTING OF WORKS

INCLUDING CHANGING COLOR

i text in any cell,
In Microsoft Excel, a user can change the properties of

; <t oli nderlined. A

including font type, size, color, as well as make 1t bold, italic, (;r :der e
user can also change the color of a cell's background and the bo ST
cell. The following picture is a graphic illustration of the font :.m i it
bar in Excel, as well as a description of each of the tools contamned Witiin it.

Changing cell background color

To change the cell background color within a Microsoft Excel spreadsheet,
follow the steps below.

1. Select the cell for which you want to change the background color.

2. Click the down arrow next to the cell color icon. It is usually displayed
as tipping paint can with a yellow underline, as shown in the example above.

3. After clicking the down arrow for the cell color, select the color you want
to make the cell background.

Changing cell border

By default, a cell does not have a border. To change the cell border within
a Microsoft Excel spreadsheet, follow the steps below.

1. Select the cell for which you want to add a border.
2. Click the down arrow next to the cell border icon.

3. After clicking the down arrow for the cell border, select the border type
you want to set for the cell.

— s Increase Decrease
Size Size
i
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}4.7 SIZE, FONT, ALIGNMENT OF TEXT, INSERTING AND
DELETING CELLS

Alignment of Text :

1. Select the cells that have the text you want aligned.

2. On the Home tab choose one of the following alignment options:

Alignment of text
Top align Middle align Bottom align

t;‘ doco./*  Bookl - Microscft Excel <EGr
1 wome e poge ;o s g A
= & Caon viil - General - I Conditional Formatting = J~=Insert ~ l A , ﬁ

‘ '—’ a B I l - A' A A7 + ] 4 Format as Table ~ I Delete ~
] P..‘“ J 5 Oa e A'( ”.a 2 Cell Styles - DFovmn (£ 3?-':“ ;:?:a&
 Chipo,,, - Font Number Styles Calis Eating

/ | N !
Bottom align Centre align Right align
To vertically align text, pick Top Align @ Button image i, Middle Align
|& Button image i, or Bottom Align.

When you have a long line of text, part of the text might not be visible. To
fix this without changing the column width, click Wrap Text.

Changing font type
To change the text font within a Microsoft Excel spreadsheet, follow the
steps below :

1. Select the cell containing the text you want to change.

want to change the font to bold, italic, or underlined, click on the B, I, or U on
the format bar.)

3. After clicking the down arrow for the font, you should be able to select
from each of the installed fonts on your computer. Click the font you want to
use, and the text in the selected cell will change.

2. Click the down arrow next to the font field on the format bar. (If you }

(10th)

R e



Note: If the selected cell does not contain any text, the font type will change

as soon as you type new text into the cell.

Changing font size

sheet, follow the

To change the text size within a Microsoft Excel spread

steps below.

1. Select the cell containing the text you want to change
next to the size box on the form
the default size is 11 or 12, as shown in the above example.

3. After clicking the down arrow for the size, you should have a selection
of different sizes to choose. Some fonts may not scale properly, so they may
have limited size options. :

Note: If the selected cell does not contain any text, the font size will change
as soon as you type new text into the cell.

2. Click the down arrow at bar. Typically,

Changing font color

To change the text color within a Microsoft Excel spreadsheet, follow the

steps below.
1. Type a paragraph in a document.
9. Select a line to change the color of a text and click on Font color option

in Font ribbon.

w the Theme of color option will appear.

3. No
(10th)




4. Select any one color of your choice. Now the color of text will be change.

%] |
i " =N

—
== HEY NEEEER
| B 9 More Colors..

Inserting and deleting cells
| If there is a need to add new data within an existing worksheet we need
to enter blank cells. So we can insert new cells, columns, or rows in the
‘worksheet.

For inserting new cells, rows, or columns in an Excel worksheet, do the

follow steps :
(i) Select the cells, rows, or columns where we want the new blank cells.

|
|
l
|
1

2 T PO T S W T TS ML T TR TR A L
1 RoliNo. Nameof the Student [ Class | Selection English Punjabi  Mindi  Maths Science Social Studies Computer ~Phy. Edu.
o 1 Vikas Th A 88 ‘89 8 80 87 85 8 &
2 weena 7h 8 OISR ET s 8 8l 57
3 Neha S | AN RN e Do 3 8 8
4 8india 7™ A 5 8 n B 8 2 % 3
L] Jasmeet Tth A 35 % L 65 8l 8 ] 6
6 sahil 7th A L 9 8 s 0 9 ) %5
7 vishal 7th 8 50 65 % 53 88 §9 n %
8 Jasmeet nh 8 oo N LR n 8 »
9 Alisha n 8 U TR N % 0 0
10 Shashi nh B C RIS SRR R n 5 %
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(i) Click the drop-down arrow attached to the Insert buttop, in

the

Z

;' group of the Home tab.

| T Qu——

; g : . AV "ug ¥ 2 o 'a ﬁ ’} 3

i »A FBn 20 3 '

P R

A s

A : g : : ’ G " X
L NeliNe \—dnwwm tnghih  Munabl Wil Math  Aclence Soclsl Studies Computer Py, fd

Fig. Displaying Insert Button under Cells group

(ii7) Click on Insert Cells on the drop-down menu as show in figure,

Insert
() Shift colls right
(3 Shit cells gown|
) Entire tow
() Entre gohumn

Lo ][ coxe |

Fig. Displaying Insert option
The Insert dialog box opens and displays the following options :
(a) Shift Cells Right

make room for the blank cells you want to insert.

Ce“g

: It is used shift the existing cells to the right to

(b) Shift Cells Down : It is used to shift existing cells down. This is the

default option.

(d) Select the desired option and click on OK button.

Deleting cells, rows, or columns

surrounding cells to plug up any gaps caused by the deletion.

(¢) Entire Row : It inserts complete rows in the cell range. We can also
select the row number on the frame before we choose the Insert command.

Unnecessary cells/rows/columns can be easily deleted. We can delete a cell
structure along with all its contents and formatting. When we delete a cell (or
an entire row or column), Excel has to shuffle the position of entries in the

(10th)




For deleting the actual cell selection rather than just clear the cell contents,
follow these steps:

(1) Type data in our worksheet.

(1) Select the cells, rows, or columns we want to delete.

!
!

A 8 C ) £ £ G H ) J

1 RollNo. Nameof the Student [ Class | selection English Punjabl Mindi  Maths Science Social Studies Computer Phy. Edu
: 1 Vikas 7th A s 839 83 80 7 8s 83 7
3 2 Meena 7h 8 55 83 80 83 80 8 81 57
4 3 Nena nh A 65 &6 7 L5 a5 82 &8 Y
S - Bindia 7h A 7 82 n s 83 2 %0 s
L) 5 Jasmeet 7th A 55 9% ) 65 81 &8 % 48
7 6 Sanil 7n A 60 31 88 s 3c 93 7 s
] 7 vishal 7th B 50 &5 %0 55 83 s 7 x
9 8 Jasmeet th 8 48 55 2 7 82 » 63 n
10 9 Alisha th & 90 78 98 69 ;| % 6C <
1 10 Shashl 7th 8 67 S0 31 60 7 7 sC 30

Fig. A School Worksheet

(iii) Click the drop-down button attached to the Delete button in the Cells
group of the Home tabe as shown in figure.

@_] .E_J ; :'xlti)Sum -

"b;ieié'Focmat
o I &2 Clear ~
i

{ Delete Cells... \ :
| &% Delete Shest Rows

| #' Delete Sheet Columns |

'UN  Delete Sheet

Fig. Delete Cells... option

(iv) Click Delete Cells on the drop-down menu.
Delete dialog box opens, displaying these options for filling in the gaps in
cells.

’ (a) Shift Cells Left : It is used to move entries from neighboring columns
- on the right to the left to fill in gaps created when we delete the cell selection.
' This is the default option.
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: neighborin
(b) Shift Cells Up : It is used t0 move entries up from neig g rows

below. 1
ows in the current cell selection,

(c) Entire Row : It removes all the r ;
delete all the columns 1n the current

(d) Entire Column : It is used to
cell selection.
Select the desired option and click OK button to delete.

4.8 ENTERING FORMULA IN CELL USING OPERATOR (+,-, X, /) ETC.

A formula is an expression which calculates the value of a cell. Functions

are predefined formulas and are already available in Excel.

(a) Addition (+)
For example, cell A3 below contains a formula which adds the value of cell

A2 to the value of cell Al.

A3 ' fr | =A1+A2
4] A B i _~.,.c___1~_,__q_ < ARE E F
1] 2

2 3

3 5|

4

e.g. cell A3 below contains the SUM function which calculates the sum of
the range A1:A2.

- i fo | =SUM(AL:A2)
despann 8 1 C'| D | & :
1] 2 ‘
2] 3

.

4
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-

2. To let Excel know that you want to enter a formula, type an equal sign

“’-)'
3. For example, type the formula A1+A2.

2 L

A3 : v S| sALAZ

B R L

(b) Subtraction (-)
1. To edit a formula, click in the formula bar and change the formula.

SUMIF X v & =afz

| C D E
ﬁ. : I
P ——

‘.
1
2
3

=A1-A2

4
2. Press Enter.




GNC

Excel performs multlphcatwn (1% AZ). NEESuSm
A3 to this result. e.g.

-
4
1 2
2
- I
s[4
5

Excel calculates the part in parentheses (A2+A3). Next, it multiplies this_
result by the value of cell Al.
(d) Divide (/)
It is simply use the forward slash (/) to divide numbers in Excel.
1. The formula below divides numbers in a cell.
9. Use the forward slash (/) as the division operator.

3. Start a formula with an equal sign (<).

Al v 5 £ =40/8

Al B C D E F G H |

4
T SI = T
2

4. The formula below divides the value in cell A1 by the value in cell B1.

a ~ J L =Al/B1

4 A s I o | & ¢

B o 4 3 : g S U
2
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5. Excel displays the #DIV/0! error when a formula tries to divide a number

by 0 or an empty cell.

C1 » fo =A1/81
A B C D 3 F G H !
1 40 o sowv/ot ]
2
6. The formula below divides 43 by 8. Nothing special.
cl v £ =A1/81
A 8 C D E F G o I
Y 43 o s.379]
2

}4.9RELATIVE REFERENCING, ABSOLUTE REFERENING
AND MIXED REFERENCING

Cell Reference is method to access the various cell.

Cell Reference is very important for calculation in Excel, Cell Reference
means to calculate important calculations by using a cell address or a range
of cells for a formula to calculate the result of the formula in a worksheet. We
can use a cell reference for a single formula or for multiple formulas.

There are three types of Cell References :
(i) Relative Reference.
(i) Absolute Reference.

(iit) Mixed Reference.

Relative Reference :

Definition : Relative reference is used by default in MS-Excel. When it is
copied to multiple cells then it changes according to cell position.

o




a formula in cell D2 = B2 + C2 anq

Example : If you want to calculate g
B3 + C3. Take the following example

you copy it to cell D3 then it becomes =
to use it.

NETWORKDAYS ~ - X  f«| =82+C2

A e e P D :
1 RollNo Name Marks Marks Total Marks
B 1 Ravi | 75| 82 |82
3 2 Knwar 40 62
4 3 Hari 62 48

Fig. Displaying forumula in cell E2
(i) Type data in a worksheet as shown in figure.
(ii) Now type our formula in cell D2 = B2 + C2.

(Zii) Drag the fill handle of cell C1 as shown in figure, you will see that
the formula becomes in cell C2 = A2 + B2.

T suM < X B axa
R
4l A g e TP :
s 70 125

o 58] 59 =A2+82
3 85 89
a

Fig. Copying formula in C2

Absolute Reference :

It is observed that sometimes you want that during copying a formula from
one cell to another, its cell reference should not be changed. So, in this case
Absolute Reference is used, in this type of reference the cell address doesn’t
change even during copying a formula. Using this reference we can keep a row/
column constant.Dollar ($) sign is used during typing a formula using Absolute
Reference. Dollar () sign can be used either for a row or a column. You caP
also use it for both together. Take the following examples to clear it
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e ———————

NETWORKDAYS ~ (* X £ | =5AS1+82

A N D
1| Marks | Marks _Total Marks
3| 55 £0 115
3| s8 52 |[=sasws2
4 50 79

Figure showing absolute cell reference

(i) Type data in a worksheet as shown in fig.
(ii) Type our formula in cell C1 = $A$1+B1

(iii) Now drag the fill handle of cell C1 as shown in figure, yo

that the formula becomes in cell C2=
in formula remain constant as C2=$A$1.

u will see

Mixed Reference :

Mixed Reference is the combination of both Relative and Absolute
Reference. In Mixed Reference a Dollar($) sign is used either to a column or
row.

(i) Type data in a worksheet as shown in figure.

(i) Now type our formula in cell C1=A1+B$1

(iii) Drag the fill handle of cell C1 as shown in figure, you will see that
the formula becomes in cell C2=A2+B$1. Note that cell address in formula has
changed in cell C2 to A2 which is an example of Relative Cell and B$1 remains

constant, in case of Abolute Reference.

i ~ SUM v (" X ¥ f =A1+BS1
| S |
Calrsa T e s §out
1 s3] 70]=a1+851 |

i 58 53 80

3 85 89 58

'y 56 75 52
5 | 70 80 96

Figure copying refrence cells
(10th)
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4.10 USING STATISTICAL FUNCTIONS

Follow the below steps to identify the Statistic
lick the insert function,

al function in excel.

1. Click the Formulas tab in excel and then ¢

Search for a function:

Or select a gategory: Math & Trig

Statistical function are given below :

1. SUM(), 2. MAX(), 3. MIN(), 4. AVERAGE(), 5. IF().

4.10.1 Sum( )

Sum( ) is used to calculate the total value of given table. You can put the
cursor in the blank cell at the bottom of the column that has the numbers you

want to sum.
Example :
1. Type a data in MS Excel as in figure.




2. Click on Insert Formula Box.

_~Formula box

BoailosCedesDadnaibataland: ool oo i satice

3. Now type the formula for sum in formula box =SUM(A1:A5) (as in figure)

Typed formula
U P s o) S i, ST S
| s - CEMSE somaas)
ol bocal aslin AR it B F: ke o Qosuinkonudl

S e 1

4. And after enter the formula for sum click Enter button. The result will
appear in the screen.

__~ CERNE -SUM(AL:AS)

Y S SO V) N WS SRR T S Y

. Total Sum of the data
4.10.2 AVG( )
The AVERAGE function is a built-in function in Excel that is categorized

as a Statistical Function. It can be used as a worksheet function (WS) in Excel,

the AVERAGE function can be entered as part of a formula in a cell of a
worksheet.
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Example :

1. Type a data in MS Excel as in figure.

| in figure)

4. And after enter the formula for average click Enter button. The result
will appear in the screen.

| (o




4.10.3 MIN()

The Excel MIN function returns the smallest numeric value in a range of
~ values. The MIN function ignores empty cells, the logical values TRUE and
- FALSE, and text values.

Example :

1. Type a data in MS Excel as in figure.

o




4.10.4 MAX()

The Excel MAX function returns the maximum nuu.leric v?lue ';r;{ z[lj ;}ange
of values. The MAX function ignores empty cells, the logical values and

FALSE, and text values.
Example :

1. Type a data in MS Excel as in figure.

i«/Formulabox
S—— A —==3
> RN = SRR

B TSR O Y DI W ST

3. Now type the formula for Max in formula box =Max(A1:A5) (as in figure)

4. And after enter the formula for Max click Enter button. The result will
appear in the screen.




4.10.4 IF()

The IF function can perform a logical test and return one value for a TRUE
result, and another for a FALSE result.

For example, to "pass" scores above 70: =IF(A1 > = 70,"Pass","Fail"). More
than one condition can be tested by nesting IF functions. The IF function can
be combined with logical functions like AND and OR.

Example :

1. Type a data in MS Excel as in figure.

| g e R S 5 e B s S oelle o e s < T i .
| M5 * Gt
A 8 ¢ P £ ; G u
1 Vikas 92 Pass
2 Harsh 85 Pass
3 Gunyeer a5 Fail
4 Surinder 79 Pass
"5 alisha 49 Fall
6 Jasmaeen 95 Pass
7 Sunita SC Pass
8§ Kulwinde( 70 Dass
9 Bani 96 Pass
L 10 Kulwant 93 Pass
' 11 Jashan 75 Pass

2. Now type the formula in formula box =IF(Al > = 70, “Pass”, “Fail”) (as
in figure) the result will appear in the figure.

Typed formula
| - G -iFADT Pass Rl X
) ' spiiatlsdlellicl o Disle o Bo doeibukaiSe o baalle Lo

" 92 Pass
85 Pass

65 Fail

4 Surinder 79 Pass
5 Alisha 69 Fail
6 Jasmeen 95 Pass
7 (Sunita 90 Pass
8 Kulwinde 70 Pass
9 Bani 96 Pass
0 Kulwant 93 Pass
; 75 Pass

=IF(A1>70,"Pass", "Failf)

AIUE_NTITUE], (value i _faise,




} 4.11 INSERTING TABLES IN WORKSHEET, EMBEDDING
CHARTS OF VARIOUS TYPES (LINES, PIE, BAR,
COLUMN, AREA) IN WORKSHEET

Inserting tables in worksheet
What is a Table ?
Table is a collection of rows and columns. A row is a horizontal line in g

table. And a column is vertical line in table. The intersection of row and column
1s called a cell.

In other words, a cell is the box that is created when your rows and your
columns intersect each other. The cell contains your data or information.

Row direction

cell cell cell

S0~mA@~—-a 33c—-00N

Fig. Table
CREATING A TABLE
We can insert a table in MS Excel using the following steps :
1. Select the range of cell which you want to convert into the table.

2. Click on insert Menu and select table option.

3. A dialogue will appear on the screen showing the cell reference.

4. In the dialogue box select the option “My table has heading row” if your
table contains heading row.




5. Click on OK button.
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|
Embedding Charts of various types (Line, pie, bar, column,
area) in worksheet

Charts

A chart is a tool in Excel that is used to represent data pictorially. A chart
can allow us to know the meaning behind our data. We can use these charts
to make comparisons much easier. You can use different types of charts to
represent data.

MS Excel Workbook can contain a large amount of data. Therefore it is
difficult for us to interpret this data. If we have numbers in our worksheet
and we want to know the highest and lowest numbers from these numbers.
So it can be done clearly by representing this data as a chart. Excel has differ-
ent types of charts to represent data, so we can choose one that most effec-
tively represents our data in the worksheet.

Elements of chart : Following are the elements of chart :

(i) Chart area : A chart area contains everything inside the chart window,
including all parts of the chart.

(ii) Data marker (or Data point) : It is a symbol on the chart that repre-
sents a single value in the worksheet. A data marker can be a bar in a bar
chart, a pie in a pie chart, or a line on a line chart. Data markers with the
same shape or pattern represent a single data series in the chart.

ow




od values such as all the values

(iii) Data series : There are group of relat :
t one data series.

in a single row in the chart. A chart can have jus

(iv) Axis : Axis is a line that is used as a major reference for plotting data
in a chart. In two-dimensional charts there are two axis the x-axis (horizon-
tal/category) and the y-axis (vertical/value).

(v) Tick mark : It is a small line intersecting an axis. A tick mark indi-
cates a category, scale or chart data series. A tick mark can have a label at-
tached to it.

(vi) Plot area : This is a area where our data is
axis and all markers that represent data points.

(vii) Gridlines : These are the optional lines extending from the tick marks
across the plot area. It make easier to view the data values represented by

the tick marks.

(viii) Chart text : Chart text is a label or title that we add to our chart.
Attached text in a title or label that is linked to an axis such as the Chart
Title.

(ix) Legend : Legend is a key that identifies patterns, colours, or symbols
associated with the markers of a chart data series. The legend shows the data
series name corresponding to each data marker.

(a) Types of Chart :

plotted and it includes the

(1) Pie Chart (it) Column Chart
(i) Line Chart (iv) Bar Chart
(v) Area Chart (vi) Scatter Chart etc.

(i) Pie Chart : Pie charts can show a lot of information in a small amount
of space. They primarily show how different values add up to a whole.

To create Pie Chart, follow the following steps :
1. Type data in MS Excel.




2. Click on Insert — Pie chart option.

3. There are different types of Pie chart in drop down option.

4. Now select the entered data.

4. The select any one pie chart from them.
: 5. The Pie chart will appear on the screen.

TN T R TIRIDe g v

[

|
e

(ii) Column Chart : A column chart is a graph that shows vertical bars
with the axis values for the bars displayed on the left side of the graph. It is a
graphical object used to represent the data in your Excel spreadsheet. You can
use a column chart when you want to compare values across categories.
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To create Column Chart, follow the following steps :
1. Type data in MS Excel.

Yelf_El Dolphins Whales

2013 8 150 80
2014 54 77 54
2015 93 32 100
2016 116 11 76
2017 137 6 93
2018 184 1 g7
2019 190 5 4

ot (BRUR 1Y 18

BESEsYa




4. Select any one Column chart from them.
5. The Column chart will appear on the screen.

- -
D e R T T

T Y S W G W— i

1
|

zma zou zms zm 2017 2018 2019 |

(iii) Line Chart : Line charts are used to display trends over time. Use a
e chart if you have text labels, dates or a few numeric labels on the hori-
tal axis. Use a scatter chart (XY chart) to show scientific XY data.

To create Line Chart, follow the following steps :
1. Type data in MS Excel.
2. Click on Insert — Line opt1on from chart ribbon.

[
3 Year Elepharts Doiphins whales | Tl —— —I

2 a3 8 150 5C  3Dtime

B ou 54 7 56 |

& o 33 2 et

3 n |

S 207 137 6 93 | 2 OnntTpes

@ »3 1 ” |
& o 150 5 4

5




2. There are different types of Line chart available in this option. Select
any one of them.

3. Now the Line chart will appear on the screen.

1
&
2y
=
&
¥ 2018
—
-
;2" 2000
i 1500 ¢ LA ‘ 2
{
= 1000 - # Bephants : ‘
500 + \ = Doiphins ‘
e —— . Whales !
QS " Oolphins !
SR Tor—f Y ‘
2P iS) gt
2013 2014 2015 20162017 2018 2019
- B

(iv) Bar Chart : A bar chart is a graph that shows horizontal bars with
the axis values for the bars displayed on the bottom of the graph. It is a graphi-
cal object used to represent the data in your Excel spreadsheet.

To create Bar Chart, follow the following steps :

1. Type data in MS Excel.

2838868
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2. Now click on Bar option from Charts ribbon. There are different types of
Bar Charts. Choose any one of them.

ag3Rv&EE

lines filled with colors. Use a stacked area chart to display the contribution of
each value to a total over time.
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To create Area Chart, follow the following steps :
1. Type data in MS Excel.

|

S T YT S S U

n=x§::§

. Wi
S
. e
e

e
l 2013 2014 2015 2016 2017 2018 2019

(vi) Scatter Chart : Use a scatter chart (XY chart) to show scientific XY
data. Scatter charts are often used to find out if there's a relationship between
variable X and Y.
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2. Now click on Scatter Chart. There are different types of Scatter Chart.
Choose any one of them.

4.13 Macros in worksheet

Macros are very useful, where we want to repeat same steps repeatedly. A
macro is a series of commands that is grouped together so that we can run
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whenever we need to perform the specific task. We can usle macros in Exce] to
save time by automating tasks that we perform frequently.

Macro recorder is the easy way to create many macros. When we record a
macro Excel stores the information about each step you take as you perform a
series of commands. We than run the macro to repeat or play back the set of
commands.

The macro recorder records every action we complete. So before we start
the process of recording it is very important to plan macro that what steps we
need to record.

We need to display Developer Tab before to record Macro in Excel. This tab

helps us to access to the macro commands, but this tab doesn’t appear by de-
fault see fig.

Home Insert Page Layout Formulas Data Review View
JA)From Access L. A [ (53 connections 3] A1z . & Cl
3 13 | ;] LA 7
3 From Web = & Properties : o e
From Other Existing Refresh fl Sort Filter 7
@FomText  sSources - Connections Al - w? Advanced
Get Fxternal Data Connections Sort & Filter

Fig. Showing tab without Developer Tab
For displaying the Developer tab perform the following steps :

(@ Click the File tab and then click Options. Excel Options dialog box ap-
pears before you :

Fig. Developer Tabh Settings

] T I —
Genss |
| = Customize the Ribbon g
ormuias I
| fnoose commanas trom Customze the Rigdon
Prooting || [Popuar Commanas . Main Tans -
Save
A chan Typer ———peeae &
| Language Borgers # Fort
Calculate Now B ALgament
Acvenced | Cante B Numoer
Conatons Formatting 8 Styes
< o Ceus
Quck Access Tooitar | Ly Copy B Latng
|| 3R Custom Son.. B Eiven
Aad-ins & cw 8 Eoage Layour
i i A" Decreass fom Sae B B oemuiay
Vi, as Devete Cons.. B Eoan
| Deiete Sheet Columna W ) Reven
|| S Detete Sheet Rows @) D view
E-mai Lo
:m Color T 8 I A%a-Ins
. ’;::' 8 B Bacigrouna Remora -
AT Rk ot < (amtes ) (o o) (e
fom Sae Customiz e
I tomzatont: | Rgser » l
"W Format Ceus. &‘ ™ r\_
3 Iw.m -}
3
Cande
Cox_ ) [camee )]
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(i7) Click Customize Ribbon in the left pane and then select the Developer
check box under Main Tabs on the right side of the dialog box see fig.

(ii7) Click OK. The Developer tab appears in the Ribbon.

Home Insert Pagelayout Formulas Data Review View Deveioper &

X -
s Properties ‘ Q‘ mport —H
g 3; @ g % &"’ gv'rewcmc . aEmawstari ‘V'.‘l 9‘3

Document

Visua! Macros Add-lns COM Insert O W e Pane
Basic Acd-Ins «  wmoce % RunDiaiog e
e f
Code Acd-Ins Controls XML Modfy

Fig. Displaying the Developer tab to work with macros in Excel
Recording a macro : To record a Macro perform the following steps :
(i) Choose Record Macro in the Code group of the Developer tab.
The Record Macro dialog box appears.

- Home Inset Pagelayout Formulas Data Review View = Developer

; T2 Record Macro j} = I*a— i ([ Propeties i 3 ‘;I'r:xm
% 33 - © :”':‘é} % k“‘ [:F d‘noan:uonpa(ks 0— port

{85 Use Relative Rierences q]\’»ew Code
Visual Macros Add-lns COM  Insert Des Source @} Refre

Basic 1\ Macro Security Adddns v Moce 1 RunDialog
Code Add-Ins Controls XML

Fig. Record Macro dialog box
(ii) Type a name for the macro in the Macro Name text box.

First character of the macro name must be a letter and the name cannot
contain spaces or cell references. Macro names are not case-sensitive.

(iii) Assign a Shortcut Key to Macro: If you have already selected a
shortcut key in Excel, the macro shortcut key overrides the Excel shortcut key
while the workbook that contains the macro is open.

Record Macro 2 X

Macro name: &

‘Macrol i aied ,
Shortout bey: ¢

CuleShite N

Sore maao n:
[ The Workbook &~ : |

Enters the names of of sales representatives, Sl
o ][ cmn]

Fig. Record Macro Dialog Box
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(iv) On the Store Macro In drop-down list, select where we want to store
the macro:

New Workbook : Create macros that we can run in any new workbooks

This Workbook : It is used to save the macro in the current workbook file.
~ created during the current Excel session.

Personal Macro Workbook : This option is selected if you want to macro

to be available whenever we use Excel, regardless of which worksheet we’e
using.

(v) Type a description of the macro in the Description text box as shown in
figure.

(vi) Click on OK. The Record Macro option on the Developer tab changes
to Stop Recording.

(vii) Perform the actions you want to record : Excel records our steps
exactly, but we can also record the steps relative to any current cell.

(viii) Choose Stop recording in the Code group of the Developer tab:
The macro recorder stops recording keystrokes and the macro is complete.




